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Das Kernprinzip von Altium Designer ist ein einheitliches Konzept für PCB-Design. In der Umset-
zung dieses Ansatzes werden Sie feststellen, dass unser Werkzeug sich von vielen der derzeit 
verfügbaren, herkömmlichen Alternativen unterscheidet. Bei diesen finden Sie noch eine Reihe 
von separaten Elementen vor, die in unserem Workflow für eine erfolgreiche PCB-Entwicklung 
zusammengeführt sind.

Als bestehender OrCAD® oder Allegro® Anwender verwenden Sie für jede Phase Ihres Design- 
Prozesses mehrere Schnittstellen und Werkzeuge. Da sich jedes dieser Werkzeuge durch eine 
spezielle Aufgabe auszeichnet und auch anders bedient wird, müssen Sie verschiedene Arbeits-
abläufe und Methoden verwalten. Während unserer eigenen Zeit als PCB-Designer haben wir uns 
immer wieder die Frage gestellt: ist dieser Ansatz wirklich effektiv?

Als wir den Altium Designer geschaffen haben, wollten wir dem Entwickler das Erlebnis präsentie-
ren, die vollständige und effiziente Kontrolle über alle Arbeitsabläufe im gesamten Design-Prozess 
zu bekommen. Um dieses Ziel zu erreichen, mussten auch wir uns überlegen, welche einzelnen 
Aufgaben zu einem kompletten PCB-Design-Erlebnis für den Entwickler dazugehören. Im Rahmen 
unseres Ansatzes haben wir die folgenden Prozesse in einer gemeinsamen Oberfläche verbunden:

• Schaltplanerstellung
• Leiterplatten-Layout
• Design-Datenverwaltung
• Regeln und Vorgaben
• Stücklisten
• Integration der Lieferkette
• Änderungsverwaltung
• MCAD-Kollaboration
• Fertigungsdokumentation

Durch die Verknüpfung dieser Elemente in einer einzigen allumfassenden Oberfläche wird das 
Arbeiten und das Hin-und Herschalten zwischen den Aufgaben so einfach wie das Auswählen 
einer Datei. Den Rest übernimmt das Werkzeug und gibt Ihnen alles an die Hand, was Sie für die 
jeweilige Aufgabe benötigen.

Unser einheitlicher Ansatz für das PCB-Design ist seit mehr als 30 Jahren durch Forschung und 
Entwicklung kontinuierlich gewachsen. Wie wir finden, ist dies nach wie vor der effizienteste Weg 
Elektronik zu entwickeln. Diese Philosophie trifft nicht nur für den einzelnen Entwickler zu, 
sondern für das gesamte Design-Team. Mehrere Entwickler können verschiedene Aufgaben am 
gleichen Projekt und in der gleichen Arbeitsumgebung erledigen. Ein Datenaustausch zwischen 
unterschiedlichen Design-Umgebungen gehört der Vergangenheit an.

Genießen Sie die Reise in die Welt von Altium Designer.

Mike Moore, Field Applications Engineer & das Altium Designer Team

Die Philosophie von Altium Designer
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Installation des Importers
Bevor man die OrCAD® Daten importieren kann, muss sichergestellt sein, dass sowohl der 
OrCAD® als auch der Allegro® Importer installiert sind. Dies kann direkt in Altium Designer mit den 
folgenden Schritten durchgeführt werden:

1.  Altium Designer öffnen.
2.  File » Import Wizard auswählen.
3.  Next anwählen.

Die nächste Seite, "Select Type of Files to Import" listet die installierten Importer.

Vorbereitung der OrCAD® und Allegro® Dateien

Während der Installation von Altium Designer kann ausgewählt werden, welche Im- und Exporter 
installiert werden sollen. Weder der OrCAD® noch der Allegro® Importer sind Bestandteil einer 
Standard-Installation und müssen manuell ausgewählt werden. 

Wenn die Einträge "Allegro Design Files" und "OrCAD Design and Libraries Files" in der oben ge-
zeigten Liste fehlen sollten, dann werden sie folgendermaßen hinzugefügt:

1.  Get More Importers am unteren linken Rand der Import Wizard Dialog-Box auswählen. 
 Dies öffnet den Extensions & Updates Tab innerhalb der Altium Designer Umgebung.

Auswahl des Dateityps im Altium Designer Import Wizard
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4.  Ganz nach oben zurückscrollen und Apply anwählen. Altium Designer muss neu gestartet 
 werden, um die Installation abzuschließen.

5.  File » Import Wizard auswählen. Die beiden Importer sollten nun in der Liste erscheinen. 

Sind die Importer installiert und gelistet, kann mit der Vorbereitung der OrCAD® und Allegro® 
Dateien begonnen werden

Vorbereitung der OrCAD® und Allegro® Dateien

2.  Configure auf der rechten Seite auswählen und zum Bereich Importer/Exporter runterscrollen.
3.  Die Einträge Allegro® and OrCAD® aktivieren.

Altium Designer Extensions & Updates section

Aktivierung der Allegro® und OrCAD® Importer im Bereich Altium Designer Extensions & Updates
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Vorbereitung der OrCAD® und Allegro® Dateien

Unterstützte OrCAD® Versionen & Dateiformate
Der OrCAD® Import Wizard für Altium Designer unterstützt eine Vielzahl von Dateiversionen, wie 
unten aufgeführt. Es wird empfohlen, die neueste OrCAD® Dateiversion(n) zu verwenden.

• OrCAD® Capture - V16.x, V15.x, V10.x, V9.x
• OrCAD® PCB Editor (Allegro) - V16.x, V15.x, V14.x
• OrCAD® Component Information System (CIS)

Anmerkung: OrCAD® Layout V9.x wird auch vom OrCAD® Designs and Libraries Files Importer 
unterstützt. Allerdings wurde das Produkt im Jahr 2009 vom Markt genommen und wird hier nicht 
behandelt.

Bitte beachten Sie die folgenden Punkte, wenn Sie den Import Wizard nutzen:

• Der Import Wizard übersetzt Schaltpläne, PCBs und CIS Bibliotheksdateien.
• OrCAD® Layout wurde durch OrCAD® PCB Editor (Allegro®) ersetzt.
• OrCAD® PCB Editor Binär-Dateien (wie. '*.brd’ für board files) sind die gleichen 

wie bei Allegro®.
• Der Import Wizard erkennt sowohl OrCAD® PCB Editor / Allegro® Design-Dateien (*.brd) 

und OrCAD® PCB Editor / Allegro ASCII Extract Dateien (*.alg). Mit der OrCAD® PCB Editor 
/Allegro® Version 15.2 oder 16.x, können OrCAD® PCB Editor / Allegro Design-Dateien 
(.brd) direkt in Altium Designer PCB Dateien (*.PcbDoc) übersetzt werden. 
Anmerkung: Eine kostenlose OrCAD® Demoversion oder Orcad® PCB Designer Lite 
ist ausreichend.

• Der CIS Teil von OrCAD® Capture CIS wird in diesem Dokument nicht behandelt. Für die 
Übersetzung von OrCAD® Capture CIS nach Altium Designer existiert eine eigene Doku-
mentation: Translating CIS to Altium Designer
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Übersetzung der Schaltpläne

OrCAD® Capture .DSN Schaltplandateien nach Altium Designer

1.  File (oben links) » Import Wizard auswählen.

6

2. Die Import Wizard Dialog-Box erscheint. Zum Fortfahren Next auswählen.
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Übersetzung der Schaltpläne
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3.  OrCAD® Designs and Libraries Files auf der Select Types of Files Seite auswählen 
 und auf Next klicken.

4.  Auf Add klicken und die zu übersetzende *.DSN Datei im entsprechenden Ordner 
 auswählen. Die Datei wird wie in der Abbildung dargestellt. Weiter geht es mit Next.
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Übersetzung der Schaltpläne
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5.  Um OrCAD® OLB Bibliotheken im gleichen Arbeitsschritt zu importieren, den Add Knopf 
 anwählen und entsprechende Dateien hinzufügen. Weiter geht es mit Next.

6.  Mit der folgenden Seite Reporting Options werden Einstellungen für das Protokollieren 
 von Fehlern, Warnungen und anderer Ereignisse aktiviert bzw. deaktiviert. 
 Zum Fortfahren Next drücken.
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Übersetzung der Schaltpläne
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7.  Es wird empfohlen, die Option auf der folgenden Seite der Dialog-Box zu aktivieren, 
 damit Rechtecke korrekt importiert werden. Weiter geht es mit Next.

8.  Als nächstes werden Optionen für den Import von Zeichnungsrahmen und der 
 Pin-zu-Pin Abstand eingestellt. Zum Fortfahren Next drücken.
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Übersetzung der Schaltpläne
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9.  Die Schematic Parameter and Net Connectivity Options Dialog-Box steuert die Art 
 und Weise, wie Parameter und Verbindungspunkte importiert werden. Die Standard- 
 einstellungen sind in der Abbildung gezeigt. Weiter geht es mit Next. 

Hier noch eine kurze Erklärung der Optionen: 
 
Auto-position parameters: Diese Option überschreibt die individuelle Positionierung der 
importierten Komponentenparameter und verwendet stattdessen die globalen Einstellungen 
aus dem Werkzeug.  
 
Disable "Mark Manual Parameters": Wenn aktiviert, werden die Parameter mit einer 
visuellen Markierung versehen. Diese Einstellung kann auch nachträglich unter DXP » 
Preferences » Schematic » Graphical Editing » Mark Manual Parameters aktiviert 
werden. 
 
Import OrCAD Junctions: Mit der Einstellung All wird ein manueller Verbindungspunkt 
an allen 3 oder 4-fach verzweigten Netzen hinzugefügt. Bei der Einstellung Only Cross 
Junctions wird nur bei 4-fach (kreuzförmigen) Verzweigungen ein manueller Verbindungs-
punkt hinzugefügt. Alle anderen Verbindungspunkte werden automatisch erzeugt. 
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Übersetzung der Schaltpläne
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10. In diesem Schritt wird das Speicherverzeichnis des importierten Projekts bestimmt. 
  Zum Fortfahren Next drücken.

11.  Als nächstes wird das Messages Panel erscheinen, das eine interaktive Liste von Status-, 
   Warn- und Fehlermeldungen beim Import liefert. Dieses Panel kann durch Klicken auf 
   das X am rechten oberen Rand des Fensters geschlossen werden.
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Übersetzung der Schaltpläne
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12.  Wenn der Import erfolgreich verlaufen und beendet ist, kann der Import Wizard 
   geschlossen werden. Weiter geht es mit Finish - die übersetzten Schaltpläne können 
   nun bearbeitet werden.

Schaltplan aufräumen
Nach einer Übersetzung ist es meist notwendig, ein wenig Aufräumarbeit durchzuführen. Der 
Grund dafür sind entweder Inkompatibilitäten zwischen den beiden ECAD-Systemen oder unter-
schiedliche Interpretationen von Objektmerkmalen.

In diesem Abschnitt werden nun die Bereiche der übersetzten Schaltpläne behandelt, die 
üblicherweise überprüft werden müssen. Der Anwender sollte dazu ein grundlegendes Verständ-
nis der Benutzung und Funktionsweise von Altium Designer haben, um die folgenden Bereini-
gungen durchzuführen. Ein Tutorial über Altium Designer findet man unter Getting Started with 
Altium Design documentation.

Für weitere Informationen über die gleichzeitige Bearbeitung von mehreren Objekten steht 
folgender Link zur Verfügung: 
http://techdocs.altium.com/display/ADOH/Editing+Multiple+Objects
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Übersetzung der Schaltpläne
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Manuell platzierte Parameter
Sichtbare Parameter von Komponenten werden in Altium Designer automatisch positioniert. Das 
bedeutet, dass das System den Parameter - darunter auch die Referenzbezeichnung (Reference 
Designator) - an einer Standardposition neben den Symbolkörper platziert. Dies ist besonders 
beim Drehen von Komponenten hilfreich, da die Parameter an einer sinnvollen und lesbaren 
Position bleiben.

Um eine exakte Repräsentation eines OrCAD® Capture Schaltplans zu bekommen, ist normaler-
weise die automatische Positionierung beim Import deaktiviert. Die Referenzbezeichnungen und 
Parameter werden dann so nahe wie möglich an ihrer ursprünglichen Position abgesetzt und wer-
den als manuell platzierte Parameter gehandhabt.

Aufgrund von Unterschieden bei der Schriftart und Größe ist eine exakte Übereinstimmung nicht 
immer möglich. Der Anwender möchte aber sicher an einigen Stellen Änderungen an der Textpo-
sition der Parameter vornehmen.

Parameter, die manuell positioniert wurden, sind mit einem kleinen Punkt gekennzeichnet, wie in 
folgender Abbildung gezeigt:

Manuell positionierte Parameter eines Schaltplansymbols
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Übersetzung der Schaltpläne
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Manuell positionierte Parameter können folgendermaßen behandelt werden: 

1. Darstellung beibehalten.
2. Darstellung beibehalten, aber den Punkt ausschalten. Der Punkt kann unter Tools » 

Schematic Preferences, im Bereich Graphical Editing mit Mark Manual Parameters 
Option ausgeschaltet werden.

3. In den Parameter Properties die Autopositionierung wieder einschalten, wie in untenste-
hender Abbildung dargestellt. Dies kann durch die Verwendung einer Kombination aus Find 
Similar Objects  und dem SCH Inspector Panel vorgenommen werden.

Weil die Autopositionierung von Parametern nur bei der Platzierung oder Rotation durchgeführt 
wird, ist der Effekt der Aktivierung nicht sofort wirksam. Die Komponenten müssen also zuerst 
noch einmal gedreht werden.

Der schnellste Weg, dies durchzuführen ist folgender:

1.  Ctrl+A drücken, um alle Objekte auf dem Schaltplan zu selektieren.
2.  Leertaste drücken, um alle Objekte um 90 Grad zu drehen.
3.  Shift+Spacebar drücken, um alle Objekte wieder in die ursprünglichen Positionen 

  zu bringen.

Alle Parameter und Referenzbezeichnungen sind nun automatisch positioniert

Parametereigenschaften in Altium Designer
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Übersetzung der Schaltpläne
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Connectivity Differences
In OrCAD® Capture erfolgt die Netzverbindung mithilfe von Netz-Aliassen, Off-Page Verbindern, 
hierarchischen Blöcken und hierarchischen Ports sowie Globals. Netze, die über mehrere Schalt-
planseiten geführt sind, werden durch Off-Page Verbinder verbunden, während hierarchische Blö-
cke Ports für die Verbindung nutzen. Globals werden bei der Verbindung von Versorgungssignalen 
verwendet. Altium Designer folgt einem sehr ähnlichen Ansatz, um die Verbindungen von Net-
zen zu definieren. Innerhalb eines Schaltplans werden dazu Drähte und Netznamen verwendet. 
In einem flachen Design, das aus mehreren Schaltplänen besteht, werden Netze mit Ports über 
die verschiedenen Seiten geführt. Off-Page Verbinder sind dazu genauso geeignet. Sie sind rein 
graphisch und enthalten keinerlei elektrische Eigenschaften. Aus diesem Grund wird empfohlen, 
Ports zu verwenden. Sollen Signale über Hierarchien geführt werden, dann werden an den Symbo-
len für die Blöcke sogenannte Sheet-Entries verwendet, die auf dem darunterliegenden Schaltplan 
mit einem Port weitergeführt werden. Sowohl Sheet-Entry als auch die Ports müssen den gleichen 
Namen haben. Auf allen Schaltplänen, auch bei hierarchischen Designs, werden Versorgungssig-
nale durch Globals miteinander verbunden.

Probleme mit der Netzkonnektivität werden dann ersichtlich, wenn das Projekt kompiliert wird 
(Project » Compile PCB Project). Im Messages Panel sind alle Fehler und Warnungen gelistet, die 
auf Ungereimtheiten bei Netzverbindungen hindeuten. Beispielsweise weist ein Duplicate NetNa-
mes Fehler auf eine fehlende oder falsche Netzübergabe zwischen zwei Schaltplänen hin.

Da hier nicht auf alle möglichen Szenarien eingegangen werden kann, empfehlen wir die Lektüre 
des Dokuments Connectivity and Multi-Sheet Design in unserer technischen Dokumentation.
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OrCAD® PCB Editor (Allegro®) nach Altium Designer
Die Übersetzung eines OrCAD® PCB Editor (Allegro®) Designs wird ebenfalls mit dem Altium Designer 
Import Wizard durchgeführt. Der Import Wizard gewährt auch bei diesem Prozess genug Flexibilität 
bei den Einstellmöglichkeiten, bevor die eigentliche Migration gestartet wird.

Unterstützt werden die Formate Allegro® PCB Design Dateien (*.brd) und Allegro® ASCII Extract 
Dateien (*.alg). Mit der OrCAD® PCB Editor / Allegro Version 15.2 or 16.x, können OrCAD® PCB Edi-
tor / Allegro® Design-Dateien (*.brd) direkt in Altium Designer PCB Dateien (*.PcbDoc) übersetzt 
werden.

Allegro ASCII Extract Dateien (*alg) können durch Ausführen eines Batch-Prozesses auf einem 
Computer mit einer Allegro® Installation erstellt werden. Dazu gibt es weiter unten einen eigenen 
Abschnitt „ASCII Konvertierung ohne Allegro®“. Die ASCII-Dateien können dann auch ohne Alle-
gro® Installation in Altium Designer PCB-Dateien (*.PcbDoc) übersetzt werden. Das heißt, dass 
nur eine Lizenz von Cadence Allegro® PCB Editor benötigt wird, um die Designs in das Allegro® 

ASCII-Extract Format (*alg) umzuwandeln. Die Übersetzung kann dann an einem Computer durch-
geführt werden.

Allegro® PCB Dateien übersetzen
Der Import Wizard wird im File Menü in Altium Designer gestartet. Als Dateityp ist Allegro® Design 
Files auszuwählen.

Dateien werden vom Import Wizard wie folgt übersetzt:

• Allegro® Binär PCB Design Dateien (*.brd) werden zu Altium Designer PCB Dateien (*.Pcb-
Doc) übersetzt.

• Allegro® ASCII Extract Dateien (*.alg) werden zu Altium Designer PCB Dateien (*.PcbDoc) 
übersetzt.

Alternativ können Allegro® Design Dateien in das Projects Panel gezogen werden, was den Wizard 
automatisch öffnet.

Übersetzung des PCBs
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Übersetzung des PCBs
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1. File » Import Wizard. auswählen.

2. Die folgende Dialog-Box erscheint. Zum Fortfahren Next drücken.
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Übersetzung des PCB
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3.  Gewünschten Dateityp auswählen (Allegro® Design Dateien). Weiter geht es mit Next.

4.  Auf Add klicken und die zu übersetzende *.BRD (Binär) oder *. ALG (ASCII) Datei im 
     entsprechenden Ordner auswählen. Die Datei wird wie in der Abbildung dargestellt. 
     Weiter geht es mit Next.

Anmerkung: Wenn OrCAD® PCB Editor (Allegro®) Design Dateien (*.BRD) importiert wer-
den sollen, ohne dass eine Allegro® Installation auf dem Computer vorhanden ist, dann er-
scheint eine Fehlermeldung. Es kann genauso passieren, dass die Fehlermeldung erscheint, 
obwohl OrCAD® PCB Editor auf dem Rechner installiert ist. Wenn die dargestellte Dialog-Box 
erscheint, gibt es im Abschnitt „ASCII Konvertierung ohne Allegro®“ Informationen darüber, 
wie man binäre *.brd Dateien in ASCII Daten umwandelt und in Altium Designer importiert.
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Übersetzung des PCBs

5. Mit der folgenden Seite Reporting Options werden Einstellungen für das Protokollieren 
von Fehlern, Warnungen und andere Ereignissen aktiviert bzw. deaktiviert. Zum Fortfahre  
Next drücken.

    Ein Protokollbericht im ASCII-Dateiformat (* .log) wird für jedes übersetzte Allegro® 
PCB-Design erzeugt. Dieses Protokoll wird in dem Unterordner *\Imported der ursprüng-
lichen Allegro®-Daten gespeichert. Um die Details der Übersetzung zu überprüfen, kann 
das Protokoll mit einem Texteditor geöffnet werden.

6. Für den PCB-Import werden jetzt die Anschlussoptionen von Polygonen und Versorgungs-
lagen eingestellt. Wenn die Option Import Auto-Generated Copper Pour Cutouts einge-
schaltet ist, werden die im  Allegro® PCB Editor automatisch generierten Aussparungen 
beim Import erstellt.

Anmerkung: Es wird dringend empfohlen, die Option Import Auto-Generated Copper 
Pour Cutouts auszuschalten, wenn irgendwelche Änderungen an der Leiterplatte in Alti-
um Designer vorgenommen werden sollen. De Standardoptionen sind in der folgenden 
Abbildung inklusive der empfohlenen Einstellung dargestellt.
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Übersetzung des PCBs

7. Alle PCB-Lagen, die in Allegro® Informationen enthalten, müssen vor dem Import einer 
Lage in Altium Designer zugewiesen werden. Layer-Mapping ist eine Zuordnung zwischen 
einer Allegro PCB-Lage zu einer PCB-Lage in Altium Designer. 
 
Der Import Wizard erstellt ein Standard-Mapping für jeden zu importierenden Datensatz 
und kann für jedes Design individuell angepasst werden. 
Wenn mehrere Allegro® PCB-Designs einen gleichen Lagenaufbau aufweisen und impor-
tiert werden sollen, dann ist es sinnvoll, das Layer-Mapping einmal korrekt vorzunehmen 
und zur Wiederverwendung abzuspeichern. 
 
Der Vorteil einer Wiederverwendung eines Layer-Mappings ist die Zeitersparnis. Der Nach-
teil ist, dass eine Voreinstellung des Mappings angepasst werden muss, wenn verschiede-
ne Designs mit einer unterschiedlichen Lagenstruktur importiert werden.
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Übersetzung des PCBs

8.  Im der Schaltfläche Menu am unteren linken Rand des Import Wizards kann die Zuordnung der 
Allegro® Lagen zu Altium Designer Lagen vorgenommen werden. Mit dem Auswählen einer der 
Altium Designer Lagen wird ein Pull-Down geöffnet, das es dem Anwender erlaubt, die momentane 
Zuordnung zu ändern. Ein Rechtsklick auf eine der Lagen zeigt eine ähnliche Liste und ermöglicht 
das Auswählen von mehreren Lagen zur gleichzeitigen Manipulation. Dies ist beispielweise hilfreich, 
wenn mehrere Lagen aus Allegro® nicht benötigt und somit nicht nach Altium Designer konvertiert 
werden sollen. Ausgewählt werden die Lagen mit Ctrl+Klick und/oder Shift+Klick. Ein weiterer Rechts-
klick erlaubt die Auswahl Set Selection to.../Other Layers/No Layer. 
 
Im selben Menü gibt es auch die Möglichkeit die Auswahl zu invertieren (Invert Selection). Dann sind 
die vormals ausgewählten Lagen de-selektiert und alle anderen selektiert. Dies ist für eine schnelle 
Anpassung des Altium Designer Layer-Mappings hilfreich. 
 
Mit den Befehlen Save Layer Mapping und Load Layer Mapping können die Einstellungen gespei-
chert und wieder geladen werden. Mit diesen Befehlen kann die Zuordnung der Lagen für weitere 
Übersetzungen von Allegro® nach Altium Designer auf einfache Weise genutzt werden.
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Übersetzung des PCBs

9. Der Zielordner für das zu übersetzende Projekt wird in der nächsten Abbildung gezeigt. 
Der Ordner kann jederzeit geändert werden.  Zum Fortfahren Next drücken. 
 
Jedes der importierten Allegro® Designs befindet sich in einem eigenständigen Unterver-
zeichnis in dem zuvor spezifizierten Zielordner. Man kann die PCB-Projekte nachträglich 
anpassen, indem man die übersetzten Allegro® Dateien in der Altium Designer Projektlis-
te in ein anderes Projekt verschiebt.

10. Der nächste Schritt übersetzt ein Allegro® PCB in ein Altium Designer PCB-Dokument 
(*.PcbDoc). Es werden dabei eine Reihe von Aufgaben durchgeführt, wie beispielswei-
se das Laden der geometrischen Daten, die Übersetzung der Komponenten, Netze und 
Durchkontaktierungen, sowie das Erzeugen von Kupferflächen und Polygonen, sodass 
dieser Prozess etwas Zeit kosten kann. In der Statuszeile am unteren Rand des Altium De-
signers kann der Fortschritt der einzelnen Aufgaben und deren Dauer überwacht werden. 
Während der Übersetzung sind die Schaltflächen Cancel, Back, Next und Finish nicht 
bedienbar.
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Übersetzung des PCBs
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ASCII Konvertierung ohne Allegro®
Wenn keine lizenzierte Allegro® Installation auf dem Altium Designer Rechner vorhanden ist, kann 
die Übersetzung mit einer Allegro® ASCII Extract Datei (*.alg) durchgeführt werden. Der folgende 
Ablauf beschreibt die Vorgehensweise zur Konvertierung einer Allegro® Binär Datei (*.brd) zu 
einer Altium kompatiblen *.alg Datei. Diese Umwandlung muss auf einem Rechner durchgeführt 
werden, auf der eine lizenzierte Allegro® Version installiert ist.

1. Benötigt werden die beiden folgenden Dateien aus dem Verzeichnis \System in der Altium 
Designer Installation: 
1.1 Allegro2Altium.bat 
1.2 AllegroExportViews.txt 

2. Beide Dateien in das Verzeichnis kopieren, in dem sich die Allegro® Binär Datei (*.brd) be-
findet.  Die *.brd Datei muss mit der Allegro Version 15.2 oder 16.x erzeugt worden sein. 

3. In einem geöffneten Command (DOS) Prompt in das entsprechende Verzeichnis navigie-
ren und folgenden Befehl eingeben: Allegro2Altium Dateiname.brd 

4. Wenn der Dateiname Leerzeichen enthalten sollte, müssen Anführungszeichen voran und 
nachgestellt werde. Beispielsweise Allegro2Altium "Datei Name.brd" 

Lesen Sie weiter, um mehr über Altium Designer und PCB-Design zu erfahren.

Wenn die Übersetzung erfolgreich beendet ist, schließt ein Klick auf Finish den Vorgang ab. 
Zum Schluss wird das übersetzte PCB-Design in Altium Designer überprüft und kann weiter 
bearbeitet werden.
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PCB-Design aufräumen

Obwohl der Importer bereits ausgezeichnete Arbeit bei einer Übersetzung leistet, kann es pas-
sieren, dass aufgrund von Inkompatibilitäten zwischen den beiden ECAD-Systemen eine weitere 
Bearbeitung des importierten Designs notwendig ist.

Design-Regeln
Allegro® und Altium Designer sind bezüglich der Definition von Design-Regeln grundverschieden. 
Allegro® verwendet einen separaten Constraint-Manager, Altium verwendet eine Matrix-basierte 
Methodik. Die in Allegro® definierten Design-Regeln werden derzeit nicht in Altium Designer im-
portiert. Sie müssen manuell in Altium Designer hinzugefügt werden.

Keepouts
Keepout-Objekte haben in Allegro eine andere Funktionsweise als in Altium Designer. In Altium 
Designer kann ein Keepout auf eine bestimmte Lage beschränkt sein und jede physikalische Form 
annehmen und gilt immer für alle elektrischen Objekte, seien es Leiterbahnen, Padstacks, Durch-
kontaktierungen und vieles mehr. In Allegro® kann im Gegensatz dazu ein Keepout so konfiguriert 
werden, dass bestimmte Objekte ausgeschlossen sind. Beispielsweise soll es Leiterbahnen mit 
einschließen, aber keine Durchkontaktierungen.

Bei der Übersetzung nach Altium Designer wird nur ein Keepout erzeugt, ungeachtet ob in Alle-
gro® alle oder nur einzelne Objekttypen ausgeschlossen sind. Auch sind die Keepout Einstellun-
gen in Allegro® und im Import Wizard maßgebend.

Gewisse Inkompatibilitäten können auch bei der Übersetzung von Footprints eine Rolle spielen. 
Footprints für den OrCAD® PCB Editor können die gleichen konfigurierbaren Keepout-Objekte ent-
halten. Häufig kommt es vor, dass eine Sperrfläche zwischen den Pads eines 2-poligen SMD-Bau-
teils definiert ist, welche das Platzieren von Durchkontaktierungen verhindert, aber Leiterbahnen 
zulässt.

In Altium Designer Footprints kann eine Sperrfläche zwischen einem solchen SMD-Bauteil eben-
falls definiert werden. Neben der Prüfung auf Vias wird allerdings auch jedes andere existierende 
elektrische Objekt (Leiterbahnen, Kupferflächen etc.) einen Fehler erzeugen. In diesem Fall würde 
ein Allegro® Keepout in ein Objekt übersetzt werden, das unerwünschte Fehler anzeigt. 

Wärmefallen in Polygonen (Kupferflächen) 
Alle PCB Design-Systeme handhaben Kupferflächen und deren Anbindungen an Pads unterschied-
lich. Wärmefallen sind in Allegro® per Definition eine individuelle Design-Regel. Diese Regeln für 
Wärmefallen bleiben beim Import in Altium Designer unberücksichtigt. Die einzige einstellbare 
Option während der Übersetzung ist in der folgenden Abbildung dargestellt.

5. Die ASCII Datei ist nun im gleichen Verzeichnis erzeugt worden. Jetzt muss die *.alg Datei 
nur noch auf einen Rechner mit einer Altium Designer Installation kopiert und der Import 
Wizard gestartet werden.
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Altium Designer unterstützt einen komplett anderen, globalen Ansatz für die Definition von Wärme-
fallen in den Design-Regeln („Polygon Connect Style“). In der Praxis ermöglicht die Methodik von Alti-
um eine effizientere Definition von Wärmefallen, da alle Einstellungen zu thermischen Anbindungen 
in Kupferflächen an einer zentralen Stelle verwaltet werden. 
 
Bei der Übersetzung nach Altium Designer wird die Stegbreite für Wärmefallen benutzt, die in der 
PADS® Options » Thermals unter „SMT Thermals“ eingestellt ist. Sofern eine andere oder spezifi-
sche Anforderung an Wärmefallen erforderlich ist, muss diese nachträglich in Altium Designer erstellt 
werden. Ein gängiges Beispiel ist die explizite Anbindung von Durchkontaktierungen ohne Wärmefal-
le. Dies kann in einer Regel mit den Einstellungen „IsVia“ vs. „All“ und Anbindungstyp „Direct Connect“ 
erreicht werden.

Weitere Informationen zur Definition von Regeln gibt es in der technischen Dokumentation unter 
Creating Design Rules.

Design-Regeln für die Anbindung von Polygonen in Altium Designer
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OrCAD® Schaltplan Symbolbibliothek
Im Folgenden wird beschrieben, wie eine OrCAD® Symbolbibliothek mit der Dateiendung .OLB 
importiert wird: 

1. File (oben links) » Import Wizard auswähle.

26
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3. OrCAD Designs and Libraries Files auf der Select Types of Files Seite auswählen und Next 
drücken.

2. Die folgende Dialog-Box erscheint. Zum Fortfahren Next drücken.
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4. Obwohl wie weiter oben beschrieben Design-Dateien im gleichen Schritt übersetzt werden 
können, wird die folgende Seite mit NEXT übersprungen.

5. Um die gewünschten OrCAD OLB Bibliotheken zu importieren, als nächstes den Add-Knopf 
anwählen und entsprechende Dateien hinzufügen. Weiter geht es mit Next.

6. Auf dieser Seite werden die allgemeinen Optionen definiert.
Zum Fortfahren Next auswählen.
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7. Mit den Reporting Options werden Einstellungen für das Protokollieren von Fehlern, War-
nungen und anderer Ereignisse aktiviert bzw. deaktiviert. Zum Fortfahren Next drücken.

8. Als nächstes werden die Ausgabeoptionen für die Bibliothek bestimmt. Weiter geht es mit 
Next
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9. In diesem Schritt wird das Speicherverzeichnis der importierten Bibliothek bestimmt. Zum 
Fortfahren Next drücken.

10. Wenn der Import erfolgreich verlaufen und beendet ist, kann der Import Wizard ge-
schlossen werden. Weiter geht es mit Finish. Die übersetzten Bibliotheken können nun 
mit Altium Designer bearbeitet werden.
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Nach Beendigung des Prozesses kann die übersetzte Schaltplanbibliothek im Projekt Panel 
geöffnet werden.

Symbolbibliothek aufräumen
In der Regel werden die Schaltplanbibliotheken akkurat übersetzt und beinhalten die Symbolgra-
phiken, Pin-Namen und Nummern, Parameter und  Zeiger zu den Footprints. Jedoch sind kleine-
re Anpassungen der Symbole nicht ausgeschlossen. 

OrCAD® PCB Editor (Allegro®) PCB Footprint-Bibliothek
Momentan gibt es keine Möglichkeit, Footprints aus Allegro® mit dem Importer direkt zu übersetzen. 
Es ist jedoch möglich, ein PCB zu übersetzen und dann daraus eine Footprint-Bibliothek in Altium 
Designer zu erzeugen. Denkbar ist auch, in Allegro eine Reihe von Bauteilen auf einer Leiterplatte zu 
platzieren und diese dann zu übersetzen. Footprint-Bibliotheken können nach einer Übersetzung 
direkt in Altium Designer erzeugt werden.

Projekt Panel im Altium Designer
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Projektmanagement
Obwohl Schaltpläne und PCB-Designs mit dem gleichen Import Wizard übersetzt werden kön-
nen, laufen sie als separate Prozesse ab. Nach der Übersetzung werden die resultierenden Daten 
in zwei unterschiedlichen Projekten abgelegt. In der folgenden Abbildung beinhaltet der Ordner 
„preview“ die Schaltpläne und der Ordner „previewpour“ das PCB-Design. Beide sind zur gleichen 
Zeit mit dem Import Wizard übersetzt worden.

Gleichzeitiges Bearbeiten von zwei importierten Projekten in Altium Designer

Soll ein geteiltes Projekt zu einem gemeinsamen zusammengeführt werden, sind ein paar Ar-
beitsschritte notwendig. Im Allgemeinen wird empfohlen, alle Projektdaten in einem Verzeichnis 
zu haben. Da in der Regel mehrere Schaltplandokumente und nur ein PCB-Dokument übersetzt 
wird, ist es am einfachsten, das PCB (*.PcbDoc) in den Ordner der Schaltpläne (*.SchDoc) zu 
kopieren. 
 
Die Projektdatei (in diesem Fall “previewpour.PrjPcb”) wird nicht mehr benötigt und kann daher 
geschlossen werden. Dies geschieht mit einem Rechtsklick im Projekt Panel und dem Befehl 
Close Projekt. Von jetzt an ist „preview.PrjPcb“ das eigentliche Projekt, an dem weitergearbeitet 
wird. Jetzt muss nur noch das PCB-Dokument (*.PcbDoc) zum Projekt hinzugefügt werden. Dies 
geschieht mit dem Befehl Project » Add Existing to Project und durch ein abschließendes Spei-
chern des Projekts.

Weitere Informationen zur Handhabung von Projekten gibt es in der technischen Dokumentation 
unter Project Management. 
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Synchronisation
Altium Designer benutzt für die Synchronisation der Schaltpläne mit dem PCB sogenannte 
„Unique IDs“. Das ist vergleichbar mit einer nur einmal existierenden Seriennummer für jedes 
Bauteil. Wenn ein Projekt von Grund auf neu in Altium Designer erstellt wird, vergibt das System 
automatisch für jedes platzierte Bauteil im Schaltplan-Editor eine „Unique ID“. 
 
Bei der Übergabe der Schaltpläne in den PCB-Editor werden diese eindeutigen Kennungen an 
die entsprechenden Footprints übergeben. Im unten gezeigten Beispiel hat das Bauteil mit der 
Referenzbezeichnung U3 sowohl im Schaltplan als auch PCB die Unique ID “QPWPFFFF”.  
 
Anmerkung: Die “Unique ID” in der Abbildung der Komponenteneigenschaften im PCB-Editor (“\
UIRYJOSQ\AFOPTWNK\”) kommen wegen des hierarchischen Aufbaus des Designs zustande.

Eigenschaften von Komponenten im Schaltplan-Editor

Eigenschaften von Komponenten im PCB-Editor
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Nach einer Übersetzung eines PCBs von OrCAD® PCB Editor (Allegro®) sind die „Unique IDs“ 
den entsprechenden Footprints nicht zugeordnet. Dies beruht auf der Tatsache, dass die beiden 
Design-Teile durch unabhängige Prozesse übersetzt wurden. Glücklicherweise gibt es ein sehr 
einfaches Verfahren, um die „Unique IDs“ zwischen Schaltplan und PCB abzugleichen. Hier die 
einzelnen Schritte:

1. ‘.PcbDoc’ Datei öffnen und Project » Component Links wählen.

Konfiguration der Komponenten-Links zwischen Schaltplan und PCB

Alle Komponenten in den beiden linken Teilen der Dialog-Box haben keine übereinstimmenden 
„Unique IDs“. Das Ziel ist es nun, die Komponenten auf den Schaltplänen mit den zugehörigen  
Footprints im PCB mit identischen „Unique IDs“ auszustatten. Dies kann manuell geschehen, in-
dem ein zusammengehörendes Paar angewählt wird und mit der Schaltfläche > in den „Matched 
Components“ Teil der Dialog-Box verschoben wird. 
 
Es gibt auch ein automatisiertes Verfahren, das auf einer beliebigen Kombination von Referenz-
bezeichnung, Kommentar und Footprint-Namen beruht. Da das Design ursprünglich in Cadence 
OrCAD® erstellt wurde, kann man davon ausgehen, dass die Referenzbezeichnungen der Kompo-
nenten zwischen Schaltplänen und dem PCB identisch sind.

2. Designator-Checkbox am unteren Rand der Dialog-Box einschalten und Comment und 
Footprint ausschalten.

3. Die Schaltfläche Add Pairs Matched By >> anwählen. Dies gruppiert mithilfe der Refe-
renzbezeichnung automatisch die Komponenten der Schaltpläne mit den Footprints im 
PCB.
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Mithilfe der Referenzbezeichnungen werden die Schaltpläne mit dem PCB synchronisiert

Bestätigung der Modifikationen

Nun stehen auch Funktionalitäten wie Cross-Probing und die Verwaltung von Änderungen (ECO) 
zur Verfügung. 
 
Es ist zu erwähnen, dass es nicht zwingend eine eins-zu-eins Übereinstimmung der Referenzbe-
zeichnungen geben muss. Im obigen Beispiel ist die Komponente X1, eine mechanische Kompo-
nente, zusätzlich auf der Leiterplatte platziert worden und hat keine Repräsentation auf einem 
Schaltplan. Das gleiche kann auch bei Befestigungsbohrungen vorkommen. Auch der umgekehrte 
Fall kann auftreten – eine Komponente kann im Schaltplan platziert werden, um in der Stückliste 
gelistet zu sein, aber keine physikalische Repräsentation auf der Leiterplatte haben. Dies könnte 
beispielsweise ein Kühlkörper sein. 
 
In OrCAD® werden solche Situationen mit dem Setzen des PSpiceOnly Parameterwertes auf „True“ 
gesteuert. Altium Designer hat verschiedene Optionen, um Komponententypen handzuhaben, die 
das Verhalten beim ECO beeinflussen. Die folgende Abbildung zeigt die verfügbaren Komponen-
tentypen, die sowohl im Schaltplan als auch im PCB genutzt werden können.

4. Um die „Unique IDs“ zu synchronisieren, Perform Update auswählen.

5. OK drücken.
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Definition des korrekten Komponententyps für einen ECO in Altium Designer

Mehr Information über die unterschiedlichen Komponententypen gibt es in dem Artikel 
Component, Model, and Library Concepts.  
 
Einem Bauteil kann jederzeit ein anderer Komponententyp zugewiesen werden. Wird der Typ „Me-
chanical“ bei der Komponente X1 auf der Leiterplatte angewendet, dann ist die Komponente vom 
ECO-Prozess ausgeschlossen. Ansonsten würde das Bauteil beim ECO-Prozess entfernt werden, 
weil es keine Repräsentation im Schaltplan hat.

Verwaltung von Änderungen (Engineering Change Orders)
Die Durchführung eines ECOs sollte alle verbleibenden Unstimmigkeiten zwischen den Schalt-
plänen und dem PCB aufdecken. Der ECO-Prozess wird unter Design » Import Changes from 
<project name> gestartet. Unter Umständen wird ein Info-Dialog (je nach Situation auch zwei) 
angezeigt, welcher dazu auffordert, die Netznamen manuell anzupassen.  Es wird empfohlen, den 
Info-Dialog mit No zu schließen, durch die Änderungsliste zu gehen und dann alle Netze umzube-
nennen sowie andere Unstimmigkeiten zu bereinigen.

Bestätigung der manuellen Abstimmung von Netznamen

Obwohl es manchmal nötig ist, einige Änderung vorzunehmen, ist die wichtigste Aufgabe das 
Umbenennen der vom System zugewiesenen Netznamen. Wie bereits im Abschnitt Schaltplan 
Import-Prozess beschrieben, werden in OrCAD® Capture und Altium Designer systemgenerierte 
Netznamen unterschiedlich erstellt. Es ist empfehlenswert, dass der ECO-Prozess die OrCAD® 
Capture Netznamen in Altium Designer Netznamen ändert, wie in folgender Abbildung gezeigt.
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Systemgenerierte Zuweisung der Netznamen in Altium Designer

Eine generelle Steuerung des ECO-Prozess kann unter Project » Project Options definiert wer-
den. Auf diese Weise synchronisiert und/oder entfernt Altium Designer eigenständig Netzklas-
sen, Komponentenklassen und vieles mehr.

Configuring project options for an ECO in Altium Designer

Es liegt in der Entscheidung des Anwenders, Änderungen zu akzeptieren oder abzuleh-
nen. Die kleine Checkbox in der ECO Dialog-Box erlaubt es dem Benutzer, eine bestimmte 
Änderung vorübergehend zu deaktivieren. Eine permanente Deaktivierung von Änderun-
gen kann im ECO Generation Tab der Project » Project Options Dialog-Box eingestellt 
werden.
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Es gibt noch eine ganze Reihe von Situationen, die Unterschiede während des ECO-Prozesses zwi-
schen Schaltplänen und PCB verursachen können. Es würde den Rahmen dieses Leitfadens spren-
gen, alle möglichen Szenarien zu beschreiben. Der Anwender sollte aber in der Lage sein, die Quel-
len für Unterschiede auszumachen, indem er die Konzepte nutzt, die Altium hierfür zur Verfügung 
stellt. Weitere Information gibt es in der technischen Dokumentation unter Finding Differences 
and Synchronizing Designs. 
 
Das Ziel sollte es sein, den ECO-Prozess so abzuschließen, dass entweder kein ECO notwendig ist 
oder keine Unterschiede, abhängig von den Optionen in den Projektoptionen  zwischen Schaltplä-
nen und PCB gefunden werden.

"No Differences" Dialog-Box

Konfiguration von Projektoptionen für den ECO in Altium Designer
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Die nächsten Schritte in Altium Designer

Nachdem alle Design-Daten erfolgreich von Cadence OrCAD® importiert sind, ist es jetzt an der 
Zeit, sich intensiver mit der vereinheitlichten Design-Umgebung von Altium Designer auseinander-
zusetzten und die Feinheiten kennenzulernen. Im Folgenden sind einige Links zu unserer Doku-
mentation, Video-Tutorials und Trainings gelistet, die Ihnen helfen werden, Altium Designer opti-
mal zu nutzen.

Dokumentation
• Getting Started with Altium Designer - ETutorial für die ersten Schritte zur Erstellung eines 

Schaltplans und PCBs.
• The Altium Designer Environment - Überblick über die vereinheitlichte Design-Umgebung 

in Altium Designer.
• Library and Component Management - Dokumentation zur Verwaltung von Komponenten 

und Bibliotheken. 

Dies ist nur ein kleiner Auszug aus unserem riesigen Archiv an Dokumentation für Altium Desig-
ner. Mehr finden Sie unter techdocs.altium.com.

Video-Bibliothek
Unsere Video-Bibliothek enthält viele Tutorials, Erklärungen zu Funktionalitäten und vieles mehr. 
Hier können Sie sich mit dem Altium Designer vertraut machen.
Die Videos finden Sie unter Altiumlive Video Library. 

Training
Bevorzugen Sie einen praxisnahen Lernansatz? Registrieren Sie sich für eines unserer Live-Events, 
darunter Webinare, Schulungen und Seminare. Eine Übersicht des Angebots finden Sie unter
Altium Events page. 

Sie benötigen zusätzliche Hilfe?
Unser Support-Team steht ihnen für alle Fragen zur Verfügung. Nehmen Sie direkt mit uns Kon-
takt auf über die Contact Us page.
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